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Frequently Asked Quest ions

 

User Manual

 

Q

 

Where is the User Manual for the Payroll Program?

 

A

 

In the payroll program, click the User Manual button on the button bar. You can 
also choose 

 

Help 

 

>

 

 User Manual

 

 from the menu bar. Select the chapter you wish 
to view.

You can also find the User Manual manually on your computer by following these 
steps:

 

1  

 

Open your Hard Drive.

 

2

 

Locate and open the Aatrix payroll program folder.

 

3

 

Locate and open the Documentation Folder.

 

4

 

Your Payroll Manual is a PDF file and can be accessed by double-clicking 
the file icon. You must have Adobe Acrobat Reader version 4.0 or greater 
installed on your computer. 

Adobe Acrobat Reader is freely available from the Adobe web site at 

 

http://
www.adobe.com.
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*If you chose not to install the manual:

 

1  

 

Locate the CD you used to install or update the Aatrix payroll program and 
insert it in the CD drive.

 

2

 

On you computer desktop, double-click the CD icon to access the contents. 
Locate and open the 

 

Documentation

 

 folder.

 

3

 

Locate and open the

 

 Aatrix Payroll Series

 

 folder.

Your Payroll Manual is a PDF file and can be accessed by double-clicking the
file icon. You must have Adobe Acrobat Reader version 4.0 or greater installed
on your computer. 

Adobe Acrobat Reader is freely available from the Adobe web site at 

 

http://
www.adobe.com

 

.

 

Q

 

How do I process the W2’s or 1099’s?

 

A

 

Go to the Home Page of www.aatrix.com and click on the Aatrix Top Pay link and 
download the Year End Guide (PDF Format).

 

Downloading and Instal lat ion

 

Q

 

I need help installing the update I downloaded from the internet.

 

A

 

Follow these instructions:

After downloading, you should have a CD icon on the Desktop (or to the location 
to which you downloaded the update.) If you have an update file with the .sea 
extension on it, you will need to unstuff the file first. To do so:

 

1  

 

double-click on the

 

 .hqx 

 

file.

 

2

 

Click 

 

Continue

 

.

 

3

 

Save to your 

 

Desktop

 

.
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After unstuffing the update:

 

1  

 

Double-click the CD Icon and click the 

 

OSX 

 

or 

 

OS 8/9 Installer

 

.

 

2

 

In the installer window, click the 

 

Update

 

 button.

 

3

 

In the Update window, enter the 

 

Unlock Code

 

 for the payroll product you 
are updating. A “putfile” (in OS 8.6 or above) or Open Pay Updater (in OS 
X) window will generate so you can choose the destination of the update 
files.

 

4

 

The installer application will look for an existing payroll application and 
display a selection if it finds more than one instance. Select the application 
you are updating and click 

 

Open

 

.

 

5

 

Allow the update to install. When the update is complete, you can launch 
the payroll application.

AOL users please be aware you may receive an “file corrupt” message when
downloading. Ignore this--the update should be fine. This is an erroneous error
message from AOL.

 

Q

 

How do I Install my State Forms from the Download?

 

A

 

Follow these instructions:

 

1  

 

Turn off any 

 

QuickTime

 

 and 

 

Virus Protection Extensions

 

.

 

2

 

Double-click the 

 

State Forms Update CD

 

 icon you just downloaded.

 

3

 

Double-click 

 

Payroll Forms Installer

 

.

 

4

 

Click the 

 

Update

 

 button. 

 

5

 

The License Agreement window will display, click 

 

Accept

 

.

 

6

 

Enter the 

 

Unlock Code

 

.
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7

 

In the next window that appears choose the destination of the update files

Generally, this is on the local hard drive in the Aatrix Payroll folder. If you are
running QuickBooks, the folder will be Aatrix Top Pay.

 

8

 

Highlight the program icon (or filename) and click 

 

Open

 

.

 

9

 

The 

 

Government Forms ƒ 

 

folder will appear in the gray pop-up menu. 

 

10

 

Click on the 

 

Extract

 

 button to install the forms.

 

11

 

Replace all duplicates if prompted.

Note: Please refer to the State Forms Update PDF Documentation included in
the downloaded Update Icon for more details.

 

Q

 

I need the Unlock Code to install the Program.

 

A

 

If you did not receive the Unlock Code with your CD, please contact Aatrix 
Software:

 

E-mail: codes@aatrix.com

Call: 1-800-426-0854 (Sales)

701-746-6017 (Technical Support)

Fax: 701-746-4393

 

Q

 

I just updated my software and my state has always had a module to set up. Why 
is this not available in version 12?

 

A

 

The payroll application has the states that require special modules built into the 
program now.

 

1  

 

In the payroll application, click on the 

 

Payroll Items

 

 tab.

2 In the Payroll Items tab window, highlight the name of the employee from 
the Employee List on the left.
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3 In the Payroll Items column, Deduction section (indicated by red text), 
double-click the state deduction to edit it.

4 Notice the pop-up menu under Select Correct Status for Standard 
Deduction. The selection available with depend on the state.

5 Select the correct status for the employee, click OK to update.

6 Repeat the process for each employee.

Q I ran the update but now all my pay history records display OT and Double OT all 
over.

A Your options are:

1  Restore a backup and run the update again. 

2 Start a new company.

3 Send the backup of the Company folder in to Aatrix for professional 
conversion ($99 fee applies).

Q I cannot get past the registration screen of the program. I have no options.

A Change the resolution on the monitor. You may need to force quit the program 
first.

Program Freezes/Crashes

Q After running the update my program keeps crashing.

A The program was not closed when the update was installed. Completely close 
the payroll program and run the update again.

Q I just ran the 2004 Tax Table update and now my program freezes when I go to 
Process Payroll.

A To fix this problem:
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1  Go to the Payroll Items tab window of the program

2 Highlight Employee List Settings

3 double-click the Federal Withholding (in red), to edit it.

• In the Edit Deduction dialogue, verify the Calculation Method is set to 
Tax Calculation. If it is not, make the correct selection from the pop-up 
list.

• Beneath the Tax Calculation pop-up is another pop-up list from which 
Federal Withholding 2004 should be selected. Make the correction if 
needed.

• Click OK to update and return to the Payroll Items tab window.

4 Double-click the State and Local Withholding, (in red) to edit it.

• In the Edit Deduction dialogue, verify the Calculation Method is set to 
Tax Calculation. If it is not, make the correct selection from the pop-up 
list.

• Beneath the Tax Calculation pop-up is another pop-up list from which 
State Withholding 2004 should be selected. Make the correction if 
needed.

• Click OK to update and return to the Payroll Items tab window.

Q Why does Top Pay quit after I select employees in the process payroll window?

A Regarding the Payroll Program crashing when you select an Employee:

This could be due to the incorrect setup of the Federal and/or State Deductions. 
To resolve this please follow the instructions below:

1  In the Payroll Items tab window, highlight Employee List Settings

2 Double-click the Federal Withholding title and verify the setup:

• Title: FE 2004 US Federal
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• Apply to: All Income items (or Custom if there is an extra income item 
that is sheltered from the Federal Withhold)

• Type: Federal Income Tax

• Calculation Method: Tax Calculation

• Select FE 2004 US Federal

• Click OK to update to all employees

3 Next, double-click on the title for the State Withholding and verify the 
setup:

• Title: IL 2004 Illinois (verify that YOUR state title in entered).

• Apply to: All Income items (or Custom if there is an extra income item 
that is sheltered from the State Withhold).

• Type: State Income Tax

• Calculation Method: Tax Calculation

• Make sure that your state is selected, this will display in a similar format, 
with the state abbreviation, then 2004 followed by the full name of the 
state (XX 2004 XXXXXX). 

• Click OK to update for all employees

QuickBooks/Top Pay

Q The Payroll Program hangs when I switch from QuickBooks 5.0 to Aatrix Top Pay.

A We have determined this is an issue with the G4 computer running on Mac OS 9.

You will need to rebuild the desktop:

1  Quit all running applications.

2 Hold down the option key and Apple key on the keyboard.

3 Restart the computer, do not release the keys until the computer reboots.
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4 You will get a message asking if you want to rebuild the desktop file, click 
OK, release the keys.

5 Locate and open the Top Pay folder.

6 Locate the Shared Reports ƒ folder.

7 Make a copy of this folder by holding down the option key on the keyboard.

8 Drag the copy of the folder to the desktop.

9 Delete the text “Shared” and the space following it from the title.

10 Hold down the option key on the keyboard and drag and drop the Reports ƒ 
folder into your company folder. In the alert dialogue that appears asking if 
you want to replace the existing file, choose Replace.

11 Hold down the option key on the keyboard and drag and drop the Reports ƒ 
folder into your Sample Company folder. In the alert dialogue that appears 
asking if you want to replace the existing file, choose Replace.

12 Reboot the computer.

Q I am using QuickBooks 5.0 and Top Pay. Why does my system crash every time I 
open the Top Pay program?

A The Employer Identification Number (EIN) must be set up exactly the same in both 
QuickBooks and the Top Pay program. In Top Pay, enter the EIN in the Company 
tab window.

Q I am using Top Pay with QuickBooks 5.0. I set up the links exactly as instructed, 
but my Payroll does not post to QuickBooks.

A If you still have the QuickBooks 4.0 program verify that version is not open. When 
you had imported the Chart of Accounts you may have imported this from 
version 4.0. Re-export/ import the Chart of Accounts from QuickBooks 5.0 and re-
link.
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Q I am using Top Pay with QuickBooks 5.0. I post my payroll to QuickBooks and it 
does not show up in the QuickBooks register.

A If you still have the QuickBooks 4.0 program, verify this is not open when you post 
your Payroll or Liabilities to QuickBooks.

Q I am using the Top Pay with QuickBooks 4.0, when I import my payroll to 
QuickBooks an older payroll date appears.

A Do a Find for Aatrix Top Pay Export; trash all copies of the Aatrix Top Pay Export 
file. Send/Post the payroll again and proceed to import into QuickBooks.

Q I just received QB 5.0 and this has Top Pay version 12 included. How can I get my 
current Top Pay company information into this new version?

A To import information from Top Pay and update tax tables, follow these 
instructions.

1  Drag the current Aatrix payroll application folder from the hard drive to the 
desktop.

2 Open the Aatrix payroll application folder by double-clicking its icon.

3 Drag the Defaults ƒ folder and the Company folder into the Top Pay folder 
(within the QuickBooks 5.0 folder). Replace any existing folders if 
prompted.

4 Trash the Aatrix payroll application folder on the desktop.

5 Load the update for the 2004 Tax Tables to update Top Pay within the 
Quickbooks 5.0 folder

6 You might be prompted for a password when opening the payroll program. 
Type in the word password in lowercase letters.

7 In the payroll program, select Edit > Preferences from the menu bar.
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8 In the Preferences window, click the Security tab. In the Security tab 
window, unmark the checkbox next to Password protect program and click 
OK.

9 In the Payroll Items tab window, highlight Employee List Settings.

10 Double-click the title Federal Withholding to edit it. 

• Title: FE 2004 US Federal

• Apply to: All Income items (or Custom if there is an extra income item 
that is sheltered from the Federal Withhold)

• Type: Federal Income Tax

• Calculation Method: Tax Calculation

• Select FE 2004 US Federal

• Click OK to update to all employees

11 Double-click the title (Your State) to edit it. (For example: DE 2003 
Delaware.) The Edit Deduction dialogue will open. In it, make the following 
entries or selections:

• Title: Title is the state abbreviation, then 2004 followed by the full name 
of the state (XX 2004 XXXXXX). 

• Apply to: All Income items (or Custom if there is an extra income item 
that is sheltered from the Federal Withhold)

• Type: State Income Tax

• Calculation Method: Tax Calculation

• Select your state from the pop-up list below Tax Calculation.

• Click OK to update to all employees
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Q I just installed the update for Top Pay, but when I go to post my payroll, nothing 
happens. I cannot import the Top Pay Export File in QuickBooks.

A Select Edit > Preferences > Program and unmark the checkbox next to Direct Link 
(QuickBooks 5.0 or later). The payroll program will then emulate version 11 and 
create a Top Pay export file.

Q How do I set up my links with QuickBooks?

A Note: We recommend consulting with your accountant when setting up the links 
regarding the required Accounts.

Verify you have these required Account types in QuickBooks:

•      (Checking) Cash Account/Type: Bank

•      Payroll Liability Account(s)/Type: Other Current Liability

•      Payroll Expense Account(s)/Type: Expense
You will need to export/import the Quickbooks Chart of Accounts into Top Pay. 
For details linking refer to Chapter 8 of Top Pay PDF manual.

**Hints for Setting up the Links**

• Net pay is always a CREDIT to the account from which you write payroll 
checks.

• Incomes are DEBITS to expense accounts.

• Deductions are CREDITS to Liability Accounts.

• Employer Paid items are CREDITS to Liability accounts AND DEBITS to 
expense accounts.

Messages/Errors

Q What is Error # 43?

A This error message indicates that there is something incorrect with your register 
files. In order to avoid this error message when recording checks, make sure your 
register file(s) are in the Registers ƒ folder; and the Registers ƒ folder is in your 
company folder located inside the Aatrix payroll program folder. To link a register 
to your company, open the program, click the Company tab and select the 
appropriate register from the Default Register pop-up. If you don't have any 
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registers, you will have to create one by clicking the New option in the Register 
pop-up. 

Q Every time I go to process payroll I get a message that says “Where is ‘35’”? 

A Normally this message indicates that your Deduction and Employer Paid 
contributions are not set up correctly. To verify that all payroll variables are 
correct, proceed as follows:

1  Access the Payroll Items tab window.

2 Highlight the first item listed under deductions.

3 Click the Edit button.

4 Verify and change the “Deduction Type” and “Calculation Method” if 
necessary

5 Click OK

6 Repeat the above steps for your Employer Contributions

Note: Pay close attention to the Federal and the State deduction items to make sure that the
calculation method is set to “Tax Calculation” and that the appropriate code is chosen.

Q I received an error 12 when trying to launch the program.

A Error 12 usually means your software or operating system is outdated.

Make sure your software is current and compatible with your Macintosh model 
and system software.

Most software applications include system requirements in the documentation or 
on the outside of the box. If your configuration does not meet the minimum 
requirements, upgrade your configuration as necessary.
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Q I ran the update but I get a message that my tax tables are expired.

A You need to run the Tax Table update. If you are updating via CD-ROM, all the 
updates are done at once. However, if you downloaded the program updated, 
you must also download the Tax Table update as a separate entity.

Q I am receiving a “CarbonLib” message when trying to update my payroll 
program.

A To correct this problem:

1  Access the Internet and navigate to http://www.apple.com

2 From the top tab bar on Apple’s main page, click on the Support tab.

On the AppleCare Support page, there is an area with a gray background titled
Search Support. First, from the popup menu directly below the text entry box,
select Downloads. Then, in the text box above the popup, type CarbonLib.
Press the Enter key on your computer keyboard.

3 On the Search Results page, download the CarbonLib file that applies to 
your needs:

• Version 1.5 CarbonLib for OS 8.6 or higher

4 After installing the CarbonLib, restart the computer and proceed to update 
the payroll program.

Q I open my payroll program and now I am being prompted for a password. I have 
never assigned a password or my password is not working.

A The password is the word password (in all lower case letters). To disable the 
password:

1  From the menu bar, select Edit > Preferences.

2 Click on the Security tab.

3 In the Security preferences tab window, unmark the checkbox next to 
Password protect this program.
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4 Click OK.

Q I get an interface lib message, what do I need to do?

A Bring up your internet browser. Go to the Apple menu, select Control Panels, 
select Software Update.

Q I just ran the update and I get a message that there are more than two FICA 
types.

A You will need to restore version 10.3. Please call Technical Support for assistance.

Q When I download the payroll update using AOL I get a message the download is 
corrupt!

A This is an erroneous error message with AOL. You can disregard the message and 
proceed to download the payroll update. 

OS 9 Error Messages

Q What is Error Type # 1, 2, or 3?

A These three types of error messages are System error messages. Any number of 
things can cause the problem (e.g., extensions). You should first determine if 
extensions are causing the problem by disabling your extensions and then trying 
to run the program again. 

Q Why do I get an Error Type # 25?

A This message is related to the amount of memory you have allocated to the 
payroll program. To set the application memory so you don't receive the error 
message, quit out of the payroll program, then select the program application 
icon by clicking on it once. Select the Get Info command from the File menu. In 
the dialogue that appears, increase the application memory size to the minimum 
preferred. Close the Get Info window and try to run the program again.

Q When I open the payroll program, I am getting Error Type -39?

A This error message may occur when opening the payroll program. It means that 
the application file is corrupt and that you need to extract a new one. This does 
not affect any other file or data. To fix the problem, reinstall the payroll program 
and select the existing payroll application when prompted.
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Q When trying to install the payroll program, I am receiving Error # 48.

A This error means that the program could not install completely because of 
duplicated items found on the hard drive. The duplicated items are the result of 
quitting in the middle of the installation, and then trying to re-install the program. 
You will need to trash the Aatrix payroll program folder from the hard drive before 
you reinstall the program.

Data/Display Issues

Q Why are the W-2s doubling the state amount?

A The state is selected twice in the State Withholding pop-up menu of the W2 setup 
screen. Click on the down arrow on the screen until you locate the second state 
deduction and set it to ‘None’. (Note that you may have to click the down arrow 
20 or more times – even though the fields don’t appear to be scrolling, they are.)

Q I just updated and now I have garbled deductions when I process payroll.

A To correct this problem:

1  In the Top Pay program, click the Payroll Items tab.

2 In the Payroll Items tab window, highlight the Employee List Settings.

3 Edit the garbled deductions.

To edit an item, click the Edit Item button on the button bar or highlight and
double-click the item. In the Edit Deductions window, type in the correct titles.

4 Verify the deductions are set up correctly.

5 Click OK to update and return to the Payroll Items tab window.

If this does not fix the problem, you may need to restore from a backup and re-
install the update again.

Q My Medicare is not being added onto the checkstub.

A You will need to manually add the Medicare Field to the checkstub. Follow these 
instructions:
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You will need to add this in to the fields of the check designer:

1  Click on the Utilities Menu in the Payroll Program

2 Select Check Designer

3 In the Description column double-click on the item titled FICA

4 Rename this Social Security, click OK

5 In the Current column double-click on the item titled FICA

6 In this window, change the “Text During Layout” field to Social Security, 
click OK

7 In the YTD column double-click on the item titled FICA

8 In this window, change the “Text During Layout” field to Social Security, 
click OK

9 Click on the Fields Menu and select Text Field

10 Type the text Medicare in the space provided, click OK, this will place the 
new Medicare title in upper left hand corner of the screen

11 You can change the font stye and size by clicking on the Font and Style 
Menu

12 Drag and drop this Medicare title under the Description column on your 
checkstub

13 Click on the Fields Menu and select New Field

Fields should be set up as follows:

• Box 1 – Normal
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• Box 2 – Deduction Types

• Box 3 – Medicare

• Text during layout: type in Medicare

14 Click OK. This will place the new Medicare Current Field in upper left hand 
corner of the screen

15 Drag and drop this Medicare under the Current column on your checkstub 
to the right of the Medicare Description)

16 Click on the Fields Menu and select New Field

Fields should be set up as follows:

• Box 1 – Year to Date

• Box 2 – Deduction Types

• Box 3 – Medicare

• Text during layout: type in Medicare

17 Click OK. This will place the new Medicare YTD Field in upper left hand 
corner of the screen

18 Drag and drop this Medicare under the YTD column on your checkstub to 
the right of the Medicare Current title)

19 Under the Current column, double-click on the (summation symbol) totals. 
You will view: Field is Accumulated

20 double-click on the Accumulated title to bring up the Accumulated Field 
Window

21 Under the Accumulating (max 50) (right side of the window) highlight FICA 
and click Remove.
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22 Under the Numeric Fields on form (left side of the window), locate Social 
Security and Medicare without the black dots before the name and 
highlight the items one at a time and click on the Assign button.

23 Close the Accumulated Field window, click OK

24 Under the YTD column, double-click on the (summation symbol) totals

25 You will view: Field is Accumulated

26 double-click on the Accumulated title to bring up the Accumulated Field 
Window

27 Under the Accumulating (max 50) (right side of the window), highlight 
FICA and click Remove button.

28 Under the Numeric Fields on form (left side of the window), locate Social 
Security and Medicare with the black dots before the name and highlight 
the items one at a time and click on the Assign button.

29 Close the Accumulated Field window, click OK

The FICA item is now split into Social Security and Medicare items.

*If you have more than one checkstub on the form, repeat steps 3-32 for the sec-
ond checkstub.

Q When I pull up my W-2 form and I am selecting the deductions on the Form Setup 
screen, the Federal and State selections are only available for 2004. Where are 
the 2003 tables to select for the W-2 form?

A When you select the Federal and State tax items, it is only a title you see. The 
actual taxes that are being brought in are from the employees’ pay history 
records. The title has changed because of the Tax Table update.
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Q I am processing Payroll for 2003 but my paystubs show the Year to Date amounts 
for 2004?

A This is due to the System Date on your computer being set to 2004. You will need 
to change the System Date to 2004 while processing the payroll.

Note: This will not affect your Payroll Reports or Payroll Records. This is an issue specific to
the YTD field on the Check Stub.

Q The 941 for the Fourth Quarter is displaying an erroneous fractions of cents.

A To correct this issue:

1  Locate the CD containing the previous update for the Payroll Program and 
insert it into the CD drive.

2 double-click the CD icon to access the contents. Locate and open the Update 
folder.

3 Inside the Update folder, open the V12 Components folder.

4 Locate and open the Government Forms folder.

5 Locate the 941 form and drag (copy) to the desktop.

6 On your computer’s hard drive, locate and open the current Aatrix payroll 
program folder.

7 Locate and open the Government Forms ƒ folder.

8 Drag the 941 form file that you copied to the computer’s desktop into the 
Government Forms ƒ folder. 

9 When prompted if you want to replace the existing form, click Replace.

To receive a new 941 by E-mail contact:
esupport@aatrix.com
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Print ing

Q Some of my state reports are cutting off information when printed.

A Verify the Page Setup is set to US Letter or Letter and not US Letter Small.

Q When I go to preview and print my reports they cut off the right hand side of 
screen.

A You will need to login into www.myaatrix.com to download the latest version of 
Payroll to resolve this issue.

Q Why do the W-2s only print 3 per page?

A If you are printing a sample, this will only print 3 on a letter size page.

Q After I ran the update my Payroll Queue Reports are displaying erroneous 
information.

A Quit the Payroll program. Locate the Employee Files ƒ folder from your 
company’s folder. Locate the Payroll Queue file and drag this to the trash. Re-
Queue your payroll.

Q I am unable to print Time Card reports from the Activities /Time Card feature in the 
Payroll Program. 

A When you go to print the Time Card, a dialogue appears in which you are asked 
to specify a date range. Verify the date range you are selecting to make sure 
you have the hours recorded

Try printing from the Report tab window of the Payroll Program:

1  Access the Report tab window. 

2 Select TC: General Detail Report.

3 Report on the Period: Select the time frame you wish to print the Time Cards 
for.

4 Click on Preview Reports.

5 Click on the Preview Menu and select to Print the report.
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Q I'm using 8.5 x 11 checkform sheets with 3 checks per page. Why does my laser 
printer print one check then skip the next two when I print from the Check 
Queue?

A Make sure you enter the appropriate number of checks you want printed per 
page in the Printing Preferences dialogue. To access this dialogue, select the 
Preferences command from the Edit menu. If you still have this problem, open the 
checkform (Utilities > Check Designer) and select the Form Setup command in 
the File menu. Make sure the size of your form is set up correctly (e.g., each 
check is 2.75 x 8.5), and the Fit as many as possible on a sheet of paper option is 
selected.

Q Why does the information from some reports get cut off when I print them?

A Some reports (e.g., General Deduction, General Contribution) have been 
designed to print in landscape mode. In order to view all the report information, 
you will need to select the Page Setup command from the File menu before 
printing the report. In the Page Setup dialogue, select the landscape mode 
option (see below).

General

Q How do I find out what my State Unemployment Tax (SUTA) rate is?

A Contact your state unemployment office to verify the rate for your business.

Q What are the Social Security and Social Security Match Upper Limits for 2004?

A $87,900 per year

Q How do I set up an Earned Income Credit (EIC) payment for my eligible 
employee?

1  Access the Employees tab window.

2 Select the employee who is EIC eligible.
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3 In the Earned Income Credit section of the window, check the box(es) that 
apply: EIC Payment Eligible, Both Spouses Filing

4 Click the Save button

5 Now access the Process Payroll tab window. 

6 Notice in the Income Section the EIC payment automatically displays with 
an amount.

7 This amount is added to the Gross and Net pay but not added to the 
Applicable wages of the deductions. Therefore you do not need to create an 
income item in the Payroll Item Screen for the employee, simply checking 
the Eligibility for the Earned Income Credit in the Employee Screen will 
create the Income Item to calculate correctly.

Q How do I add a “Miscellaneous” payroll deduction to a new employee? This is for 
employee's health insurance premium, I can't find it listed in the “Payroll 
deductions” general list.

A To add a Miscellaneous Payroll Deduction such as Health Insurance:

1  Access the Payroll Items tab window. 

2 Highlight the Employee List Settings.

3 Click the New button in the Deduction section.

4 Enter the deduction Title.

5 Apply to All Income Items (unless you need to shelter from an Income item, 
then you would select custom)

6 Type would be Miscellaneous or Special Group.
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7 Select your Calculation Method as something like Flat Amount or Percent 
of Gross, leave the amount or % at 0 (zero) for now.

8 Click OK.

9 If there is a check mark in front of this item, click on the check mark.

10 Click Yes to remove for all employees.

11 Next, select the applicable employee.

12 Click on the left of the Health Deduction to place a check mark there and 
assign to this employee.

13 Double-click on the Deduction title.

14 Add the specific amount or rate applicable to this employee.

15 Click on the Upper limit radio button if the deduction has an upper limit.

16 An upper limit screen will appear to put in the applicable upper limit.

Q I clicked the Send button in the Send/Post window and a GetFile window opens 
when I try to post to MacP&L. How do I fix this?

A This may occur if you have moved your payroll and P&L folders to a different 
computer or if you have performed a clean re-install of your Mac OS. 

In the GetFile window, please do the following:

1  Double-click the Hard Drive.

2 Double-click the Mac OS 9 System folder.

3 Within the System folder, double-click the Preferences folder.

4 In the Preferences folder, double-click the MacP&L Preferences folder.
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5 Select the MacP&L Preferences file and click the Open button. Upon opening 
this file, your payroll records should export correctly and appear in the Print 
Checks window in MacP&L.

Q Why can’t I access my Payroll Quickhelp screens?

A The Payroll QuickHelp file may have been moved out of the Defaults ƒ folder or 
has been trashed. If you locate the Payroll Quickhelp file on your hard disk, move 
it back into the Defaults ƒ folder. If you can't locate the Help file, you can drag 
the Payroll Quickhelp file into your Defaults ƒ folder from your original installation 
disk.

Q What is a Default Stationery?

A Default stationery is a file that contains the basic setup for any new employee 
you would hire. You normally have Federal Withholding, State Withholding, Social 
Security, and Medicare assigned to your deductions. For employer paid you 
would have FUTA, SUTA, Social Security Match (Company), and Medicare Match 
(Company).

Q I have my liability accounts in QuickBooks, do I still need to use the Liability 
Registers in Aatrix Top Pay?

A The liability registers in Aatrix Top Pay allow you to keep track of the liability for 
each payroll variable. You do not have to use them in order to use Aatrix Top Pay.

Q When sending (exporting) Payroll data to an accounting program, I get this 
message: Warning - no records were exported. Please check the date in the 
export window. What does this mean?

A The program sends checks by date. The date you enter in the export window 
must match a date in the employee’s pay history records. Go to Pay History of an 
employee paid and verify the date in the pop-up menu.

Q I made a liability payment and the amount of the check is wrong.

A First, make sure the Master List is selected. This ensures all employees are 
included. Run the Pay History Detail Report (totals only) for the same period as 
the liability check. If the reports match the amount on the check, examine the 
individual’s pay history records for errors. If they do not match, compare the 
totals to find the error.
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Q When I process payroll, my deduction/employer paid item is still calculating for a 
particular employee when they have reached their limit. How can I fix this?

A First, make sure the upper limits are set properly. To do so, click on the Payroll 
Items tab window and double-click the deduction/employer paid item in 
question. If the upper limits are correct, go through each check from Pay History 
records, making sure the correct amount is listed in the wages column for this 
deduction/employer paid item.

Q When I process Payroll it keeps entering the same hours all the time. I would like it 
to be zero. How can I change this?

A Aatrix Top Pay has a default set of hours based on your pay period. For example, 
Weekly will be 40 hours, biweekly is 80 hours, and semi-monthly is 86.67 hours. You 
can change the default to zero in the Payroll Preferences window.   Select 
Preferences in the Edit menu. In the window that appears, click the Payroll tab. 
Mark the Alternate Default Hours checkbox and enter zero. 

Q My Federal/State tax tables are not calculating correctly!

A In the Employees tab window, confirm the settings for Pay Period, Filing Status, 
and Exemptions are correct. Also, verify that any tax-exempt income items or 
deductions in the Payroll Items tab window are correct. Additionally, some states 
require additional setting up for each employee. For more information, please 
see Appendix A of the User Manual.

Q Why do I only get three out of four copies when printing the Employee/Employer 
copies of Form W-2?

A You may have clicked the Print Sample button instead of the Print W2s button. 
Print Sample prints only one copy of the form for proofing purposes. 

Q When I process my Form 941, I get a fraction of cents that is unacceptably large.

A Bring up a Pay History Detail Report (totals only) for the same period. Compare 
wages and amounts for Federal, Social Security, Social Security Match, Medicare 
and Medicare Match. Make adjustments as needed.

Q Why do I get zeroes in my Form 941 report’s line 14 (deposits made) when I have 
checks in the program for that payment?

A This can be fixed by going to the Liabilities tab window, selecting Federal 941 
and clicking the Edit button. Make sure the Report Type is selected as Federal 
941. If needed, refer to Chapter 7, Liabilities for more information. Or you can edit 
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the payment in the Check Register. In the Edit Entry window, make sure to mark 
the check box next to the pop-up menu stating that it is a 941 payment.

Q I updated my system (or transferred my Aatrix folder) and tried to open the 
program. Now it wants a password! 

A For OS 9: When the computer system is updated, it places Pay Defaults in your 
System Preferences folder in the old system folder. In moving the Aatrix program 
to the new computer, you might forget to move this folder from the old system 
folder into the new System Preferences folder. Simply enter the default password 
(which is the word password in lower case letters) and then change it to the one 
you want; or locate the old Pay Defaults file and move it to the new system.

Q When I view my check register there is nothing in there. It was fine last time I 
viewed it...

A Check your Display and Limit by options at the top of the window. You may have 
a box that is incorrectly checked/unchecked. 

Q When I installed Aatrix Top Pay it did not contain Disability Insurance and I need 
to have it.

A Aatrix Top Pay automatically contains the basic deductions for any state. If your 
state requires disability insurance, you will need to create a new payroll item(s) in 
the Payroll Items window. For more information, please see Chapter 5: Payroll 
Items. 

Q I do not have a separate cash account for payroll. Do I need to reconcile my 
Payroll Check register?

A If you do not have a separate payroll register you don’t need to reconcile the 
check register in payroll. The Aatrix Top Pay program has a payroll register and it 
will always enter the payroll check and liability checks into the register. You can 
still use the cash accounts you have in QuickBooks. This will not interrupt anything 
in Aatrix Top Pay.

Q How can I include reimbursed income in employees payroll?

A In the Payroll Items window, click the blue New button in the Income section of 
the window. Enter a title like Mileage Reimbursement. Set the Type to 
reimbursement. Set the Calculation method to regular for a straight 
reimbursement amount. Assign the reimbursement to the applicable employees.
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Q My adjusted gross wage is incorrect, is there a way to correct this?

A All wages are stored in each employee’s pay history records. There will be a 
wage column for each deduction and employer paid. You can change this 
value for each paycheck in the pay history for all the employees. After making 
the change, your reports will reflect this change. However, you may want to 
check your deduction for the correct exemptions.

Q How do I track employee vacation time in Aatrix Top Pay?

A Aatrix Top Pay will track vacation, sick, and holiday time. To do so, in the 
Employees window select an employee, then click the Vacation, Sick, Holiday 
button. (Be sure that the Income item ‘Vacation’ is assigned to the employee.) 
You can accrue time on just about any method. The most common is to set a 
number of earned hours per pay period and number of hours per year.

Working with T ips

Q I need to set up my tipped employees so they can make a minimum per hour 
rate. How can I do this?

A In some cases you will need to make sure the employee receives a minimum pay 
amount. For this instance you need to set up another income source for minimum 
per hour. You would create a new income in the income sources. Set the title to 
‘minimum per hour’ and the income type to ‘Minimum per hour’. The calculation 
method would be set to ‘Normal’. Then type in the rate you want to set for the 
minimum pay rate per hour. Assign it to the employee. When you process payroll 
the minimum per hour will only calculate if the gross divided by the number of 
hours worked is less then the rate entered into the minimum per hour Extra 
Income.

Q How can I set up tipped income for my employees?

A In the Payroll Items window, click the blue New button in the Income section. 
Enter Tips in the title. Set the Type to Tips. The Income Settings should 
automatically be set to Normal. Then assign the Tips income item to the 
applicable employees.
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Sett ing up 401k

Q How can I create a 401K deduction?

A A 401K is set up in the Payroll Items window. In the Deductions section, click the 
red button and type in the title 401K. Set the Deduction Type to Pension. Select 
the appropriate Calculation Method (example: Percent of Gross). Some 
employees may elect a straight amount while other may want a percentage, this 
can be edited individually for each employee. Leave the Calculation Amount to 
zero since each employee may have a different amount for their 401K 
deduction. Assign the 401K deduction to an employee by selecting the 401k 
deduction and clicking the Edit button. In the Edit Deduction window, set the 
calculation method (percentage or flat amount) and enter the amount for the 
selected employee. Click the OK button and proceed to the next employee.

Q My 401K has a limit. Can I set a limit?

A You can set an Upper limit or Lower limit on any deduction. For the 401K you may 
have an upper limit on the amount contributed per year. To do so, in the Payroll 
Items window, double-click the 401k deduction and click the Upper Limit radio 
button. In the window that appears, set it to Amount per year or Amount per pay 
period.

Q Can I set a 401K for an employee for whom the company pays part of the 
pension?

A A 401K can be created for both employee and employer. You would set the 401K 
for the company‘s share in the Employer Paid section. Click the green New 
button and title it 401K Company. Set the Employer type to Pension. Assign the 
401K Company to the employee and then set the calculation method. The 
calculation method may not always be the same as the Employees share. You 
would also create a deduction for the employee paid portion of the 401k 
deduction by clicking the red New button.
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OS 9 Program incompatibi l i t ies
The following programs are known to cause problems with our payroll programs:

• Adobe Type Manager and Adobe Type Reunion
Turn off the extension/control panel for these utilities when installing and running your payroll program.

• Auto Doubler
If you have Auto Doubler installed on your computer, you will need to set it up so that it does not compact
your payroll folder and any files within the payroll folder.

• Norton Ut i l i t ies F i le Saver
If you have the Norton Utilities File Saver installed on your computer, you will need to set it to update at
shutdown.

• QuickTime
When installing or updating this application, turn off QuickTime in the Apple Control Panel and Exten-
sions.
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